
  

Technical Note: ACTIVE Governance Cloning, version 7.1 1 

Technical Note: ACTIVE Governance Cloning 
Introduction ........................................................................................................................ 1 
AppsRules Cloning................................................................................................................ 2 

Concurrent Manager Server Product Top ............................................................................ 2 
Forms Server Product Top ................................................................................................ 4 
Apache Server Settings..................................................................................................... 5 
Setting the UTL Path ........................................................................................................ 5 
Setting Up LogicalApps Migration....................................................................................... 6 

Installing ACTIVE Governance Infrastructure .......................................................................... 7 
Refreshing ACTIVE Governance on the Destination Instance .................................................... 8 

Copying the Schema......................................................................................................... 8 
Setting ACTIVE Governance Data Connections and Properties .............................................. 8 
Copying Business Views and Reports ................................................................................. 9 
Setting Business Objects Connectivity .............................................................................. 11 

 

Introduction 
An ACTIVE GovernanceTM instance consists of ACTIVE Governance and Business Ob-
jects (a reporting program), both of which run in a web browser. It works in concert with 
AppsRules, a set of LogicalApps applications that run within the Oracle Applications EBS 
environment. ACTIVE Governance may connect to multiple instances of Oracle Applica-
tions, each running its own instance of AppsRules. 

One can “clone” an Oracle Applications instance — use Oracle procedures to reproduce a 
source installation and configuration on a clean destination instance. A source Oracle in-
stance that includes AppsRules can be cloned as well, although some additional steps must 
be completed for AppsRules components to run correctly in the destination instance. (It’s 
assumed that AppsRules patch levels are the same in both the source and destination en-
vironments.)  

Owing to a restriction in Business Objects infrastructure requirements, neither ACTIVE 
Governance nor Business Objects can be cloned. Thus to reproduce an ACTIVE Govern-
ance configuration in a new instance, one would complete the following procedures: 

• Clone each Oracle Applications instance that connects to the ACTIVE Governance 
instance, together with the AppsRules applications running within Oracle.  

• Perform a fresh installation of ACTIVE Governance infrastructure in the new envi-
ronment (only once per host, no matter how often ACTIVE Governance is refreshed 
on that host). This installs ACTIVE Governance and Business Objects program files.  

• Refresh ACTIVE Governance on the destination host. This includes importing the 
ACTIVE Governance schema from source to destination instance; establishing con-
nectivity between the destination ACTIVE Governance instance and the cloned Ora-
cle EBS instances; copying Business Objects business view and reports from source 
to destination instance; and establishing connectivity between the destination Busi-
ness Objects instance and the cloned Oracle EBS instances.  
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AppsRules Cloning 
AppsRules components run on the database, forms, and concurrent manager servers on 
which Oracle EBS is installed. When an Oracle Applications instance includes AppsRules, a 
cloning procedure consists (in broad terms) of the following steps: 

• Use Oracle cloning procedures to copy source-instance files onto a clean destination 
instance. Oracle procedures permit a user to determine what components to include in 
a cloning operation. Be sure to include the following: 

– The AppsRules database schema (conventionally called XXLAAPPS). 

– The LogicalApps Top (the file structure in which AppsRules program files are 
installed). 

• Complete tasks on the concurrent manager server so that LogicalApps files run with 
Oracle. These tasks include: 

– Run a configuration script, laconfig.sh, in the LogicalApps Top. 

– Re-create soft links between fndcpesr and a set of LogicalApps .prog files: 
LAGENLIB.prog, LAMIGRATE.prog, LATKPROF.prog, and LAIMPORT.prog. 

– Verify that the Oracle environment file correctly sets the shell variable for the 
LogicalApps Top. 

• Complete tasks on the forms server so that LogicalApps files run with Oracle. These 
tasks include: 

– Edit a file called LAFORMSGEN.prog to ensure that the environment file sources the 
correct environment for the forms server. 

– Regenerate forms libraries. These include LACHGCEN, LABRSQL, LACUSTOM, and 
CUSTOM. 

– Verify that the Oracle environment file correctly sets the shell variable for the 
LogicalApps Top. 

• On the Oracle Apache server, ensure that the servlet properties file correctly sets the 
base path variable for the AppsRules application. This step is performed only for an 
instance that is to run in servlet mode. 

• Ensure that the UTL (utility) path setting in the AppsRules application refers to a 
valid UTL directory on the database server file system. 

• Ensure that LogicalApps migration is set up correctly. 

Procedures for completing these steps appear in the following sections. 

Concurrent Manager Server Product Top 

Complete the following procedure on the LogicalApps Top directory of the concurrent 
manager server on the destination instance: 

1 Open a UNIX shell to the concurrent manager server host. 
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2 Source the Oracle EBS environment to the shell. 

3 Navigate to the LogicalApps Top/bin directory. 

4 Modify the file permissions on a file called laconfig.sh to allow execution. Use this 
command: 
chmod +x laconfig.sh 

5 Execute laconfig.sh.  
$ laconfig.sh 

Running the laconfig.sh file produces a series of command-line prompts. Respond to 
them as follows: 

a You are prompted to enter the LogicalApps application short name. If that name 
is other than XXLAAPPS, type it and press the Enter key. (Case is not significant.) 
If the short name is XXLAAPPS, simply press the enter key in response to the prompt. 

b A prompt displays a path to a Java executable; you must confirm that this is the 
path to the Java executable used by Oracle Applications. It is, if you sourced out 
the Oracle Applications shell environment before running the laconfig.sh file (no 
matter how many Java executables reside on your system). It may not be, if you 
did not source out the Oracle Applications shell environment and have more than 
one Java executable on your system. 

If the prompt displays the path to the Oracle Applications Java executable, type Y 
(for yes) and press the Enter key. If not, type N (for no) and press the Enter key, 
then type the full path to the Java executable used by Oracle Applications and 
press the Enter key again. 

c A prompt displays a path for a file that sets the Oracle Applications environment; 
you must confirm that it is correct. The default value is taken from the shell as 
$APPL_TOP/$APPLFENV, and this selection is always safe; to accept it, press Y (for 
yes) and press the Enter key. But what’s really at issue is the file that sets the 
LogicalApps Top, which is a subsidiary file of $APPLFENV. You may wish to 
specify it instead; if so, type N (for no), then type the full path to the appropriate 
file and press the Enter key. 

d The following prompt appears: 
Choose your node configuration from below: 
1.  All servers (CM/Forms) share the same application top  
    directory 
2.  Forms server has different application top file system  
    than concurrent managers  
3.  Exit Program 

Enter 1 if all database, forms, and concurrent servers exist under a single applica-
tion top, or 2 if each exists under its own application top (regardless of whether 
they reside on a single machine or more than one).  

e You are prompted to enter the number of distinct application tops used by forms 
servers. Type the number and press the Enter key. 
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f For each of the application tops you include in the count in step 5, you are 
prompted to select a method for transferring files to the application top directory. 
Enter one of the following and press the Enter key: 

• 1 for secured shell (ssh) 

• 2 for remote execution (rexec) 

• 3 for telnet 

• 4 for local file system (copy) 

• 5 for manual 

g For each application top, you are prompted for supporting information if you have 
selected any of the first four access methods. (Method 5, manual, requires no sup-
porting information.) 

• Server host name if you selected option 1, 2, 3, or 4 

• Full path to LogicalApps binary files if you selected option 1, 2, 3, or 4 

• User ID if you selected option 1, 2, or 3 

• Password if you selected option 3 

Entries are validated, so that if you enter incorrect supporting information you are 
prompted to try again. 

6 Re-create the soft links to fndcpesr for the .prog files. Use the following commands: 
$. ln –s $FND_TOP/bin/fndcpesr LAGENLIB  
$. ln –s $FND_TOP/bin/fndcpesr LAMIGRATE  
$. ln –s $FND_TOP/bin/fndcpesr LATKPROF  
$. ln –s $FND_TOP/bin/fndcpesr LAIMPORT 

7 Verify the Oracle EBS environment file to ensure that the base path shell variable sets 
the correct LogicalApps Top path. In most cases, the environment file can be located 
through use of the following command: 
echo $APPL_TOP/$ALLPFENV 

If the application short name for the LogicalApps product is XXLAAPPS, the base path 
shell variable is XXLAAPPS_TOP. This variable should point to the top directory of the 
LogicalApps application. For example:  
XXLAAPPS_TOP="/oracle/bin/ebus115/appl/xxlaapps/11.5.0" 
export XXLAAPPS_TOP 

Forms Server Product Top 

Complete the following procedure on the LogicalApps Top directory of the forms server 
on the destination instance: 

1 Open a UNIX shell to the forms server host. 

2 Source the Oracle EBS environment to the shell. 

3 Navigate to the LogicalApps Top/bin directory. 
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4 In a text editor, open a file called LAFORMSGEN.prog to determine if the environment 
file sources the environment for the forms server. The correct environment would 
have FORMS60_PATH and ORACLE_HOME variables set to valid Oracle directories. 

5 Regenerate the forms libraries: 

• Delete plx libraries from $AU_TOP resource (LACHGCEN, LABRSQL, LACUSTOM, CUSTOM). 

• Regenerate libraries in this order: LACHGCEN, LABRSQL, LACUSTOM, CUSTOM. The 
following is a sample command for library compilation: 
f60gen module=LACHGCEN, user_id=apps/apps module_type=library 
compile_all=special 

6 Verify the Oracle EBS environment file to ensure that the base path shell variable sets 
the correct LogicalApps Top path. In most cases, the environment file can be located 
through use of the following command: 
echo $APPL_TOP/$ALLPFENV 

If the application short name for the LogicalApps product is XXLAAPPS, the base path 
shell variable is XXLAAPPS_TOP. This variable should point to the top directory of the 
LogicalApps application. For example: 
XXLAAPPS_TOP="/oracle/bin/ebus115/appl/xxlaapps/11.5.0" 
export XXLAAPPS_TOP 

Apache Server Settings 
Ensure that the base path variable of the LogicalApps application is set to the correct path 
in the servlet properties file. This step is critically important when the Oracle EBS instance 
is configured to run in servlet mode. 

Setting the UTL Path 

Make sure that the UTL path setup in the AppsRules configuration references a valid 
UTL directory for this environment: 

1 Open the AppsRules application: In Oracle EBS, select the LogicalApps responsibil-
ity in the Navigator. In the application list under the LogicalApps heading, click on the 
AppsRules link. 

2 With the LogicalApps — AppsRules form displayed on screen, click on Tools in the 
menu bar and AppsRules Configurations in the Tools menu. 

3 An AppsRules Configurations form appears: 
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In its UTL path field, confirm that the UTL path is set to a valid directory as per your 
database parameters configuration. If not, enter the path to a valid directory in the 
field; then click on File in the menu bar and Save in the File menu. 

 
Note  
To verify that this UTL path is a valid one, you can run the following SQL query 
against your database. It should run with no errors and show that a file called 
validutl.txt is created in the directory displayed in the UTL path field of the Oracle 
Rules Configurations form. 
set serveroutput ON 
declare 
v_directory varchar2(240); 
file_handle UTL_FILE.FILE_TYPE; 
begin 
SELECT utl_pathname 
INTO v_directory 
FROM la_br_configurations; 
dbms_output.put_line(v_directory); 
file_handle := utl_file.fopen(v_directory,'validutl.txt','W'); 

sys.utl_file.put_line(file_handle,'testing line1'); 
sys.utl_file.put_line(file_handle,'testing line2'); 
sys.utl_file.put_line(file_handle,'END;'); 

sys.utl_file.fclose(file_handle); 
END; 

Setting Up LogicalApps Migration 

Set up the LogicalApps migration utility. You need to specify connection information in 
environments to and from which you plan to transmit data — in this case the source and 
destination instances involved in the cloning. You need to know the host name, instance, 
SID, and database instance port for each environment. This information is found in the 
TNSNAMES.ora file, which is located in ORACLE_HOME/ network/admin. 

1 With AppsRules open, click on LogicalApps Utilities in the menu bar, then on Migra-
tion Setup in the Utilities menu. A Migration Utility form appears. 

 
2 Ensure that the Setup Host Names tab is selected. 

3 In the Host Name column, enter the host name (machine name) for each of the 
machines hosting the database and involved in the migration. 
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4 In the Description column, you may enter a description for each host name. (This step 
is optional.) 

5 Click on the Setup Instances tab. The following form appears: 

 
6 In the Host Name column, select the host name for each of the machines from the list 

of values. (The entries are those defined in the Setup Host Names tab.) 

7 In the Instance and Port Name columns, type the instance name and port number that 
corresponds to each host name. 

8 Under User Name, type the value APPS for each entry. Under Password, enter the 
password for the APPS user. 

9 Click on File in the menu bar and Save in the File menu. When the configuration is 
saved, the system automatically generates and displays a connection string. Close the 
Migration Utility. Click on the × symbol in the upper right corner of the form. 

Installing ACTIVE Governance Infrastructure 
As noted earlier, you need install ACTIVE Governance infrastructure on a host machine 
only once, no matter how often ACTIVE Governance is refreshed on that host. To do so, 
refer to the ACTIVE Governance Installation Guide. (Use the version of the Guide appro-
priate to you: one describes installation on a Linux or UNIX server, and another on a 
Windows server.) 

First, ensure that the destination host meets requirements. These are described in the fol-
lowing sections of chapter 1, “ACTIVE Governance Installation Overview”: 

• Supported Operating Systems 

• Hardware Requirements 

• Software Requirements 

Next, complete the procedures described in the following sections of the Installation 
Guide, in the order listed here. From chapter 2, “Installing Server Components”: 

• Preparing to Install 

• Installing Oracle Client 

• Loading Files in the Staging Directory 
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• Installing ACTIVE Governance Infrastructure 

• Configuring the Business Objects Server  

• Accommodating Firewalls 

• From “Installing the ACTIVE Governance Schema,” complete only the following 
procedures: 

– Beginning the Process 

– Copying and Editing ACTIVE Governance Files 

Finally from chapter 4, “Configuring ACTIVE Governance,” refer to the section titled 
“Configuring Licenses.” Complete only the steps pertaining to a Crystal Reports license. 

Refreshing ACTIVE Governance on the Destination Instance 
Once the ACTIVE Governance Infrastructure is installed on the destination instance, you 
can move ACTIVE Governance and Business Objects data from the source instance to the 
destination instance. Broadly, this involves four steps: 

• Copy the ACTIVE Governance schema from source to destination instance. 

• Connect the destination instance of ACTIVE Governance to cloned Oracle EBS in-
stances, and configure properties for it. 

• Copy business views and reports from source to destination instance. 

• Configure data connections between the destination instance of Business Objects and 
cloned Oracle EBS instances. 

Copying the Schema 

First, use a database import/export utility to export the ACTIVE Governance schema from 
the source instance to the destination instance. If this is not the first time you are reproduc-
ing an ACTIVE Governance configuration, ensure that the destination ACTIVE Govern-
ance schema contains no data before importing from the source.  

Setting ACTIVE Governance Data Connections and Properties 

Log on to the destination instance of ACTIVE Governance to establish connectivity with 
data sources and to set properties. You do both from the Administration tab of the ACTIVE 
Governance Platform: 

• Configure a data connection between ACTIVE Governance and each of the cloned 
Oracle EBS instances. Use the procedure described in the section titled “Configuring 
Data Sources,” which is in chapter 4 (“Configuring ACTIVE Governance”) of the 
ACTIVE Governance Installation Guide. 

• Ensure that properties are set properly for the destination host. Use the procedure de-
scribed in the section titled “Setting Properties,” which is in chapter 4 (“Configuring 
ACTIVE Governance”) of the ACTIVE Governance Installation Guide. In particular, 
set the following properties as indicated: 
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Property Value 

businessObjects.reportSecurity true 

businessObjects.server Supply the ACTIVE Governance server host name. 

businessObjects.serverPort 6400, if you accepted default port values during 
infrastructure installation. If not, supply the value 
you set for CMS_PORT.  

businessObjects.username Administrator 

In addition, you must set the password for the Business Objects Administrator user on the 
destination host. This cannot be done from the ACTIVE Governance Platform. To com-
plete this task, use the Business Objects Central Management Console (CMC), as instructed 
in the “Configuring the Business Objects Server” section of chapter 2 (“Installing Server 
Components”) in the ACTIVE Governance Installation Guide.  

Copying Business Views and Reports 

A typical ACTIVE Governance installation involves installing Business View Manager 
(a Business Objects component) on a Windows client and using it to import “business 
views” and to “publish” reports. If you are installing ACTIVE Governance on a destina-
tion instance in order to duplicate the installation on a source instance, you can forgo this 
process and instead import reports on the destination instance, from the source. 

Deleting Business View and Reports from a Destination Instance 

If reports exist on the destination instance (because an earlier version of ACTIVE Gov-
ernance had been installed), delete them before importing the new reports. (If not, skip 
ahead to “Importing Business Views and Reports to a Destination Instance” on page 10.) 

1 From the Business Objects folder under Windows Start, log on to the Business View 
Manager on the Windows client system. Use the following logon values: 

• System: The host name of the destination ACTIVE Governance server 
• User Name: Administrator 
• Password: The password created for your destination instance 
• Authentication: Enterprise 

2 In the Repository Explorer, right-click on the Report Center folder. A pop-up menu 
appears; click on its Delete option. 
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3 Open the Central Management Console in a web browser. Use the following URL: 
http://HostName:PortNumber/businessobjects/enterprise115/admin/en/ 
admin.cwr 

Replace Hostname and PortNumber with the values appropriate for the destination in-
stance of ACTIVE Governance. 

4 Log in to the Central Management Console. Use Administrator as the user name and 
supply the password for your site. 

 
5 Select the check box for the Report Center folder and click on the Delete button. 

Importing Business Views and Reports to a Destination Instance 

To copy business views and reports from a source to a destination instance, you use an 
Import Wizard, which is accessible from the Business Objects folder under Windows Start, 
on the Windows client system on which Business View Manager is installed. 

1 From the initial Wizard dialog, click on the Next button. 

2 In a Specify Source Environment panel, enter or select the following values: 
• Source: BusinessObjects Enterprise XI 
• CMS Name: The host name and port number of the server from which you want 

to copy files, separated by a colon. For example, aspen:6400 
• User Name: Administrator 
• Password: The password created for your source instance 

Then click on the Next button. 

3 In a Specify Destination Environment panel, enter the following values: 
• CMS Name: The host name and port number of the server to which you want to 

copy files, separated by a colon. For example, cobra:6400 
• User Name: Administrator 
• Password: The password created for your destination instance 

Then click on the Next button. 
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4 In a Choose Objects to Import panel, select the following check boxes:  
• Import users and groups 
• Import application rights 
• Import corporate categories 
• Import folders and objects 
• Import repository objects 

Ensure that all other check boxes are cleared.  

5 Click on Next buttons until you come to an Import Object Principals Option panel. In 
it, make sure that an Enforce Rights Fidelity check box is selected, and click on the 
Next button. 

6 In a Choose an Import Scenario panel, select the lower radio button (“I want to update 
the destination system by using the source system as a reference”) and the check box 
associated with it (“Automatically rename objects if an object with that title already 
exists in the destination folder”).  

7 Click on Next buttons until you reach a Select Users and Groups panel. In it, ensure that: 
• In the Groups field, all check boxes are cleared. 
• In the Subgroups and Users field, the Administrator and Everyone check boxes 

are selected, and all others are cleared. 
Then click on the Next button. 

8 In a Select Folders and Objects panel, select the Report Center folder. (Ensure that 
this folder appears below an entry identifying your source instance. This should be 
the default.) Then click on the Next button. 

9 In an Import Repository Objects Options panel, select the Import All Repository 
Objects radio button. Then click on the Next button. 

10 In an Information Collection Complete panel, click on the Finish button. 

Setting Business Objects Connectivity 

Using Business View Manager, connect to the destination instance (see logon settings on 
page 9) and update data connections to your cloned Oracle EBS instances. For the proce-
dure, see the section titled “Establishing Data Connections” in chapter 3 (“Deploying 
Reports”) of the ACTIVE Governance Installation Guide.  

When you have finished doing so, restart ACTIVE Governance. 
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